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ScadaTEC Software Product Licensing

OVERVIEW

This document explains how ScadaTEC software products can be registered and authorized for
continuous use. Although these examples apply to all ScadaTEC products, screen images from
ScadaPhone will be used for illustration purposes.

All ScadaTEC products support 2 methods of Licensing:
1. Licensing by software authorization code.

2. Licensing by ScadaTEC USB License dongle.

ScadaTEC offers 3 Licensing levels for ScadaPhone and they are based on the maximum number of
Alarms that can be monitored:

1. ScadaPhone Unlimited: supports Unlimited Alarm Tags
2. ScadaPhone 200: supports maximum of 200 Alarm Tags
3. ScadaPhone Lite: supports maximum of 32 Alarm Tags

LICENSING BY SOFTWARE AUTHORIZATION CODE

When a ScadaTEC product is installed, an 8-character Computer Key is generated. This Key is displayed
on the Program Information screen.

Program Information 2 x|
There are 2 ways to access the ‘Program information’

5CADATEC

1. On the Main Menu, select Help -> About

ScadaPhone
2. Onthe Main Menu, select File -> Program -> About Copyright 1999 - 2019 ScadaTEC
Rgistration Version 6.2,3,1202

Computer Key : 88D2-0018

Serial Number: Mot Assigned

This Computer Key and the Software version number Current Run Time : 00:02: 17
require a matching Authorization Code, in order for Accumulated Run Time : 5.805 Years

. Mo USE Key Detected
ScadaTEC software product to run continuously. TRV REECEE
Unlimited System Enabled (via Registry code)

Web Server: Enabled (via Registry code)
Free Upgrades : 302, 168 Days remaining
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Obtaining Authorization Code

An Authorization Code can be obtained by contacting ScadaTEC Support either by telephone (1-775-
348-7471) or by email (support@scadatec.com). Provide the Computer Key and the ScadaPhone
version number installed. The 8-character Authorization Code will be issued.

Entering Software Authorization Code

To enter the Authorization Code, on the ‘Program Information’ screen click on the blue text
“Unregistered: xx:xx:xx remaining in trial period”. If the unregistered software has run for more
than one hour in Run mode, the message is replaced by: “one hour demo hasexpired”.

Select “Permanently Authorize ScadaPhone”. Enter the Authorization Code on the next screen If
an Extended Code is issued, enter it in the Extended Code space and click “OK".

Program Information ), EE
Aathorization Optors 3|

§CADTE m——— [ — .

- B To register ScadaPhone, contact ScadaTEC by phone at
| Temporarily Authorize ScadaPhone | T75-348-T471, or email sales@scadatec.com. In order to register,

ScadaPhone you will need to provide ScadaTEC with the “Computer Key”
Permanenthy Authorize ScadaPhone | (displayed below] for each machine on which ScadaPhone will
Copyright 1959 - 2013 ScadaTEC be used. The "Computer Key” is computed using information
Version 6.2.3.1202 Authorize ScadaPhone Lease | unigque to each machine.

Computer Key : B285-F0BC Upen registering, you will be issued an autherization code for

Serial Mumber: Mot Assigned Cancel ﬁ::hlit:iwhich will be placed into the Windows registry on each
Current Run Time : 01:41:55
Accumulated Fun Time - 5.805 Years Computer Key: 82B89-F@BC
No UISE Key Detected Version: 6.2.3.1282
One hour demo session has expired

Authorization Code : |DFBF -9Ce8
Web Server: Not Authorized I you have been given an "Extended Code”, enter it in

the edit box below; otherwise, leave this box blank.
Extended Code : |25E::—n93ﬁ|

[ ok ] conca |

Note: The Extended Code is issued when you renew Annual Support. The first-year technical
support and software upgrades are included at no additional cost. After the first year, the User
can purchase extended support for a nominal fee.

The Extended Code updates the Program Information screen to show the number of days
remaining for Free Upgrades. You are entitled to all Software updates and unlimited Technical
Support if your screen shows more than ‘0’ days remaining for Free Upgrades.
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WEBSERVER LICENSING

All ScadaTEC products implement an HTTP Web Server Interface. There is a core set of features for
viewing status logs and modifying datapoints implemented in every product, but ScadaPhone also
has features to support alarm reporting, alarm acknowledgement, alarm summary and schedular
modifications.

The WebServer is an option that requires a separate license.

If your ScadaTEC software product is licensed by a USB Key, the WebServer license is added to the
same Key.

If the software is licensed by a Registry Code, a separate Authorization Code is issued for the
WebServer. Authorization Code is generated using the same Computer Key as the main product.

Enter WebServer Authorization Code

To enter the Web Server Authorization Code, on the Program Information screen click on the blue
text: Web Server: 00:XX:XX remaining in trial period

5CADATEC

ScadaPhone

Copyright 1999 - 2019 ScadaTEC
Version 6.2.3.1202

Computer Key : 8289-F0BC

Serial Number: Mot Assigned

Current Run Time : 00:05:20

Accumulated Run Time : 5.806 Years
No USB Key Detected
Unlimited System Enabled (via Registry code)
‘Web Server : 00:54:39 remaining in trial period
Free Upgrades : 259,258 Days remaining

Enter the WebServer Authorization Code in the blue box and click OK. WebServer option will be
Enabled.

ScadaPhone's Web Server is a non-standard option which must be purchased and
authorized in addition to ScadaPhene's standard license.

To enable the Web Server, contact S5cadaTEC by phone at 775-348-7471, or email
sales@scadatec.com

You will need to provide ScadaTEC with the "Computer Key” from each
computer on which the Web Server will be used.

The "Computer Key" is computed using information unique to each computer.

Computer Key: 8289-F@BC

Authorization Code : |¥

If you would like to Temporarily Autherize this optional feature for a 30-
day evaluation period, you can request 2 Temporary Authorization from
ScadaTEC (free of charge).

In order to issue a Temporary Autherization code, you will need to provide
sales@ScadaTEC.com the Temporary Authorization Key (shown below) in
addition to the Computer Key. Upon receipt of your request, ScadaTEC
will provide a Temporary Autherization Code to be entered in the space
below.

Temporary Authorization Key : 5B1D-99DF

Temporary Authorization Code : -

Ok I Cancel I
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AUTHORIZATION VIA USB LICENSE KEY/FLASH DRIVE

The USB key/Flash Drive is comprised of two separate : =
drive Volumes: S——————

C (.D 5; TECINC

775-388-7471 | s scadatec.com

e SCADATEC (I:) SCADATEC (read Only)
| oy SCADATECDAT (3:)| SCADATECDAT (read-write)

The SCADATEC volume contains license encryption information.

The SCADATECDAT volume is used to hold additional license information and storage for backups
which can be used to restore your ScadaTEC product installation in the event of computer failure.

The backup features available with the flash-drive are integrated into each ScadaTEC product.

There are two things that should be backed-up on the USB key in order to make a timely
restoration of your Project.

e The ScadaTEC software installation program
¢ The most recent user-defined project needed to run yourinstallation

ScadaTEC product installation programs released after May, 2015 automatically detect the
presence of a ScadaTEC USB key; if a ScadaTEC USB key is detected, and it does not already have a
copy of the currently running Installation program, the user is prompted to make a backup copy of
the installation program on the USB key for future restoration needs.

The user-defined projects are also backed-up if the USB key is | s SCADATEC (I:)
detected when the user is creating a Restore Point from the File / - Us: D;S:éé’)

Cada
Project / Create Restore Point menu item (a feature available in = —

most ScadaTEC products). OPCHub
Install Programs

. . . . . . Project Backups
The back-ups are organized into application-specific folders in the SemtPhone

read-write in read-write volume of the USB key. Install Programs
Project Backups
j ScadaTEC L:cense.DoNotDelele__

USB Key Activation Procedure
USB License Key is shipped without the license installed. The license code is emailed separately.

There are two types of Codes sent for initializing the USB License key:

1. If the key is blank and needs to be initialized with application information as wellas
customer information, a Whole Key Code isissued.

2. If the code is only needed for upgrading the authorization for a specific application or
for Extended Support, a 28-character App Code is issued.
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Because both of these codes are somewhat lengthy, there is a convenient feature built into the
ScadaTEC License Manager for transferring the codes via the windows clip board.

The Whole Key Code

The following box shows a sample Whole Key Code that you will receive to initialize the USB
License Key:

35FAFBEFS74EABAFS1483ATEBDCTEAESDEBBCCASC41DCBEACTEC4G6BETV2BFOAS1FBCDOT1BEB55282
CO455FEASBS4B0A3AFESBO49590E7ED270A0BED1EBALASIBADZSCFA4ASI Z4F0SBEE5E095FFEIDE2]
7EB3029BBDCED455EEDC39F5196 8856062 B6FEEE7 2C0162035590CF1C73AG5SEDT B13 D3 6653958A39

CF3B53BCD55955741A13F9BFDGBEBCB5698215CF1F1313151ABB25E7ASCASB2BC21997 BT C77090ES

97EASF113926879CC2ACD4ARE4EEDSFEDS380D56509BACE446240627 BE4BFECET32EOSA4D 2553487

Enter the Whole Key Code

To enter the Whole Key Code, click on File -> Program -> About and Registration. Click on the blue text
'USB Key detected.....'

Click on ‘Enter Whole Key Code’

# USB Key License Information

The USB key attached to your system contains the folowing license information:

Entry Type | Entry Attributes |
License Count USB key contains authorization for 0 applications

To update this license, you must contact the ScadaTEC sales department:
3t 775-348-7471 (US) or by ermail at sales@ScadaTEC.com.

To process your request, support will need your unigue USB Key ID:
USB Key ID 9708-0226

After obtaining a new code from ScadaTEC Sales, enter the code in the
space below and the new license details wil be written to your USB key.

Key Upgrade Code

Submit Key Upgrade Code Enter Whole-Key Code | Cancel I

Copy the Whole Key Code that was emailed to you by ScadaTEC, and paste it into the next
image as shown below and click ‘Write to Key’.

Whole-Key Code x|

Paste Whole-Key Code (from confirmation email) below; lines not consisting of 80 hexadecimal digits will be ignored.

3SFAFBEFS74EABAFS1483A7EE0CT6AES0EBBCCA5C41DCEEACTECA668ETT28FOAG1FBCDDT18859282 |
C0459FEA3B94B0ASAFESB049996E78D276A9BED1EBAIAG38A025CFA4A5324F098665E0ISFFESDE2L
TEB3029BBDCE6D455EEDC39F519688560B286FBB672C0162D35590CF1CT3A6SEDTEL3D36653958A39
CF3B53BCD55955741A13F9BFD6EESRCBS5B98215CFIF1313151A8B25ETASCASB28C21987687CTT090ES
97ED5F113926579CC2DCDQESEQBEDSFEDQBSODSESOQBBCQQQGZ‘1062TEEQSHCE732E05R4D255h4ET

Clear Edit Box and Paste From Clipboard | Write To Key Cancel

Click on ‘X’ to close the Whole Key Code window.
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The Program Information screen displays ‘Unlimited System Enabled (via USB key)’

USB Key Detected : 9708-0226

Web Server : 00:58:37 remaining in trial period
Free Upgrades : 1.631 Years remaining

Enter the 28 Character Upgrade Code

To enter the Upgrade Code to the USB Key, on ‘Program Information’ screen click on the blue text

“Free Upgrades: xx:xx:xx Days remaining".

Enter the 28-character App Code and click on the ‘Submit Key Upgrade Code’ button.

Note: The ‘Submit Key Upgrade Code’ button will become active only after you enter the Upgrade

Code.

= USE Key License Information E

USB key contains authorzation for 1 apphcation
App:ScadaPhone Version=6.01; Tier=[7] Full System; 5/N=1234567800;
License Type=Permanent; SupportExpDate=2019/01/01 00:00:00.000;
WebServerLicense=None;

To update this license, you must contact the ScadaTEC sales department
at 775-348-7471 (US) or by emal at sales@Scada TEC.com.

To process your request, support wil need your unigue USB Key ID:
USB Key ID 9708-0226

After obtaining a new code from ScadaTEC Sales, enter the code in the
space below and the new license details wil be written to your USB key.

Copy the 28-character Upgrade Koy Ik Coce
———————>f4p4p-4FAA-3012-5c11-E1C2-FIAF-C304|

Code here

Submit Kav‘mgmda Code Enter Whole-Key Code | Cancel I

Click here to enter the
Upgrade Code
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TEMPORARY AUTHORIZATION CODE

The Temporary Authorization option allows 30 days of full application functionality and is usually
used during testing; this allows the user to conduct a long-term test before purchasing a
Permanent license.

For short-term testing, most ScadaTEC products will fully function, in Runtime, for a trial period
of one hour without an Authorization Code; after the one-hour demo has expired, the application
is forced into Development Mode and can be restarted to resume testing. There is no limit to the
number of times the one-hour trial period can be used.

Obtaining Temporary Authorization Code

To obtain a Temporary Code, two Computer Keys are needed which can be obtained as shown

in the image below:

e 8-character Computer Key and
e 8-character Temporary Computer Key.

Program Information 7]
| Temporary Authorization El

SeadaPhone can be termperarily suthorized for 30 days for the purpeses of
CADA I E C lang term testing/evaluation. In order to receive this temporary authorization
_. thorization Options @ |4 you must contack ScadaTEC's sales office by email or phone and provide the
piiee sales office with the 2 codes displayed in bold text below (the Computer Key
and the Temporary Authorization Key). Make sure to obtain this informaticn

Scadaphone What would you like to do? from the machine you plan to test on.

Copyright 1999 - 2020 ScadaTEC | Temporarily Authorize ScadaPhone I ScadaTEC Sales Dept, T75-348-7471 (US), or email Sales@ScadaTEC.com

Version 6.2.3. 1220

After you've obtained a temperary authorization code, you can enter it in the
Computer Key : 8250-0758 How:

Permanently Authorize ScadaPhone | space provided b

Serial Number: Not Assigned Authorize ScadaPhone Lease | Version: 6.2.3.1220
Current Run Time : 00:02:43 Computer Key: 8258-8758
Accumulated Run Time : 5,808 Years Cancel | Temporary Authorization Key: SC85-985F
No US8 Key Detected Temporary Authorastion Code: [~
Unregistered : 00:57: 10 remaining in trial period
Web Server ¢ 00:57: 10 remaining in trial period

You will receive an 8 character alapha neumeric Temporary Code. Enter the Code in the
Temporary Authorization Code box.

TRANSFER AUTHORIZATION CODE

When migrating ScadaTEC applications from one computer to another, the method for
transferring the license depends upon whether your system uses the USB Key or Windows-

Registry-based authorization.

If your system uses a USB Key, you simply move the key to the new machine.
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If your system has Windows-Registry-based authorization, you will need to perform the
Transfer Authorization procedure outlined below.

The ScadaPhone’s Registry-based authorization can be transferred to another computer running
the same Major & Minor version number (the first 2 numbers of the 4-part version number) of
ScadaPhone.

Transfer Code Procedure

To Transfer Authorization, place ScadaPhone in Development Mode and click: File | Program |
Transfer Authorization and follow these steps.

Step 1: Confirm that the ScadaPhone Version on the Target Computer (computer that is yet
to be authorized) is identical to the Source Computer (computer that is currently authorized), by
checking the box for ‘The version on the target Computer Begins with X.X’. Click the ‘Proceed’
button.

+ ScadaPhone =] E3
Fie Mode Options Window Logs Modem(s) WebServer Scadalink TTP Scheduler Session Help
Projsct  » |pdaPhonelProjects\Gmail_Tests

bt Regeiraton
Exit Create Shortouts |
""—'—m - Explore Program Folder Stepl | Step2 | Step3 | )
larm Grou i
'_HE Serial Number — ScadaPhone’s registry-based authorization can be fi i to another P
running the same Major & Minor Version of ScadaPhone.
Uninstall ScadaPhone:
. P The Major & Minor Version numbers (the first 2 numbers of the 4-part version number) |

must match because they are used to compute the valid authorization code. The last 2
numbers (the Release & Build numbers) do net effect the computation of the
autherization code.

‘When the registry-based ization is from this comp to another, the
Computer Key for this i ion of ScadaPhone will be changed (thereby
de-authorizing ScadaPhone on this computer).

This instance of ScadaPhone is version 6.2.2.1220

Please verify before proceeding:
[¥ The version on the Target Computer begins with 6.2
Cancel I
[15:43:39 Development Mode 4

Step 2: Copy the Computer Key from the Target Computer and enter it into space provided in
the Source Computer.

Target Computer Source Computer

Program Information 713
stepl |[step2 | step3
5CADATEC In order to compute Authorization Codes for the Target Computer, you must obtain

the Computer Key from the Target Computer.

SaadaPhone Te obtain the Computer Key from the Target Computer: Launch ScadaPhene on the
G _ ScadaTEC Target Computer and copy the Computer Key displayed on the Program Infermation
1999 - 2020 window (Mote: This is a hexadecimal number, '0° = zero, not the letter '0°)
WARNING: Clicking the Transfer button will de-authorize this installation of
ScadaPhone. Make SURE that you have entered the CORRECT key.

Version 6.2.3.1220
Computer Key : 92C2-253F
Serial Numiber: Not Assigned

Current Run Time : 00:22:12 Target
Acgumidated Run Time : 5,808 Years pomauter
H- B |
o 8 ey e »[02¢2-258F  Transter |

Uniimited System Enabled (via Registry code)
Web Server : 00:37:47 remaining in trial period
Free Upgrades : 90. 189 Days remainng

Cancel |
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Step 3: When the Transfer button is clicked, the Taget Computer Authorization Code and
Target Computer Extended Code, are displayed. The Extended Code carries the Warranty
information.

Transfer Authorization Code

Stepl | Step 2 ||Step3 |

This installation of ScadaPhone has been de-authorized (the Computer Key for this
installation of ScadaPhone has been changed)

Use the codes displayed below to authorize ScadaPhone on the Target Computer. If you
need to see these codes after this window has closed, they have also been recorded to

the Activity Log.
Target Computer Target Computer
Authaorization Extended Code
769C-F393 32FF-CAFE

Close |

Step 4: Enter the Authorization Code and the Extended Code on the Target Computer the same
way the Authorization Code is entered.

Program Information 2] x| ScadaPhone Registration E3

To register ScadaPhone, contact ScadaTEC by phone at

T73-34E-T4T1, or email sales@scadatec.com. In order to register,
éCADATE' youwill need to provide ScadaTEC with the "Computer Key”
(displayed below) for each machine en which ScadaPhone will
be used. The "Computer Key” is computed using information

mdapha"e B unigue to each machine.

- _ Temporarily Authonze ScadaPhone Upen registering, you will be issued an autherization code for
Capyright L‘H‘j LRy EEIRIED | I each key which will be placed inte the Windows registry on each
Version 6.2.3,1220 Permanentty Authorize ScadaPhone | machine,
Computer Key : E709-298A

Serial Mumber: Not Assigned Authorize ScadaPhone Lease | Computer Key: E789-298A
Current Run Time : 00:03:55 Version: 6.2.3.1228

Acoumulated Run Time = 5.808 Years Cancel Authorization Code:  [769C-F393

No USB Key Detected I you have been given an "Extended Code”, enter it in
Temporarily Authorized = 29,667 Days the edit bow below; othenwise, leave this bow blank.
Web Server : D0:56:04 remaining in trial period Extended Code: |32FF-CAFE

e |

If all the numbers were entered correctly, you will see a confirmation similar to this:

o Full system extended code accepted

(775)348-7471, International | (888) 722-3283, USA & Canada

www.scadatec.com | support@scadatec.com
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